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1.1

1.2

1.3

1.4

INTRODUCTION

GENERAL INTRODUCTION TO AD LDS IN MIVOICE MX-ONE 6.X OR
ABOVE

Active Directory Lightweight Directory Services (AD LDS) role, is formerly known as Active Directory
Application Mode (ADAM). Any user can provide directory services for directory-enabled applications
without incurring the overhead of domains and forests and the requirements of a single schema
throughout a forest.

It is a Lightweight Directory Access Protocol (LDAP) directory service that provides data storage and
retrieval support for directory-enabled applications, without the dependencies that are required for the
Active Directory Domain Services (AD DS). You can run multiple instances of AD LDS concurrently on
a single computer, with an independently managed schema for each AD LDS instance.

ABOUT THIS GUIDE

This guide describes the processes for setting up AD LDS and getting it running. You can use the
procedures in this guide to configure AD LDS on servers that are running the Windows Server® 2012
operating system.

REQUIREMENTS

Before you start using the procedures in this guide, do the following:
e Check the availability of at least one test computer on which you can install AD LDS.

e Log on to Windows Server 2012 with an administrator account.

STEPS FOR GETTING STARTED WITH AD LDS

The following sections provide step-by-step instructions for setting up AD LDS. These sections provide
both graphical user interface (GUI) and command-line methods for configuration setup of AD LDS.

e Enabling AD LDS in Windows Server

e Creating AD LDS Instance

e Restarting the AD LDS Instance

e Creating an Admin User in AD LDS

e Checking User authentication

e Adding Attributes to UserProxyFull Class

e Editing UserProxyFull Object Class as User Object class

¢ Modifying MS-AdamSyncConf File

e Synchronizing Users from Active Directory to AD LDS Instance
e Checking Synchronized Users in ADLDS

e Enabling LDAPS (SSL) for AD LDS

e Using AD LDS as a User repository in Provisioning Manager (PM) Application
e Uninstalling of AD LDS Instance and AD LDS Roles from Server

Note: To maximize your chances of successfully completing the objectives of this guide, it is important
that you follow the steps in this guide in the order in which they are presented.
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2 PREREQUISITE

AD LDS server should be a part of Active Directory Domain, so that users can login into AD LDS
server using their respective User IDs and Passwords from active directory. User display name and
User ID must be same in Active Directory created for all users.

2.1 ENABLING AD LDS IN WINDOWS SERVER

If any of the organization wants to use AD LDS as a proxy to AD Server, then they can follow this
document to enable AD LDS as a proxy server.

To enable AD LDS in Window Server, do the following:

1. Click Start, and then click Server Manager. You can do this from Task Bar or from Start /
Administrative Tools menu.

2. Select the Server Manager> Add Roles and Features. Click Next. The following screen

appears.
= Add Roles and Features Wizard | = | o
3 e . = DESTINATION SERVER
D (’_‘1(_\'-' e you h("g In WIN-ISQIEN LT 2 mxone local
4
gefore You Bagin This wizard helps you install roles, role services, or features. You de?errmne which ro_les__ role services, or
= features to install based on the computing needs of your organization, such as sharing documents, or

hosting 2 website.

To remove roles, role services, or features:
Start the Remove Roles and Features Wizard

Before you continue, verify that the following tasks have been completed:

* The Administrator account has a strong password
* Network settings, such as static IP addresses, are configured
* The most current security updates from Windows Update are installed

If you must verify that any of the preceding prerequisites have been completed, close the wizard,
complete the steps, and then run the wizard again.

To continue, click Next.

[] Skip this page by default

3. Choose Role-based or feature-based installation. Click Next.
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. . DESTINATION SERVER
Select installation type WIN-ISQISN3LK72. mxonelocal

Select the installation type. You can install roles and features on a running physical computer or virtual

Before You Begin - B .
machine, or on an offline virtual hard disk (VHD).

(® Role-based or feature-based installation

Server Selection ) . .
Configure a single server by adding roles, role services, and features

) Remote Desktop Services installation
Install required role services for Virtual Desktop Infrastructure (VDI) to create a virtual machine-based
or session-based desktop deployment.

| nstal | [ cancel

4. Select Idapstest server from the server pool. Click Next.

DESTINATION SERVER

Select destination server ISRNELKT2 meromadocal

Before You Begin Select a sarver or a virtual hard disk on which to install roles and features.

Installation Type ® Select a server from the server pool
() Select a virtual hard disk

Server Roles Server Pool
Featuras

Filter:

Name IP Address Operating System

10.5.04 Microsoft Wine rver 2012 R2 Datacenter

1 Computer(s) found

This page shows servers that are running Windows Server 2012, and that have been added by using the
Add Servers command in Server Manager. Offline servers and newly-added servers from which data
collection is still incomplete are not shown.

[<previous | [ Net> | [ mnstat | [ Cancel |

5. Mark Active Directory Lightweight Directory Services from the list of roles and click
Next.
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DESTINATION SERVER

Select server roles WIN-ISQIEN3LX72 mxone local

Before You Begin Select one or more roles to install on the selected server.

Installation Type Roles Description

Server Selection o . ) ~ Active Directory Lightweight

= | O ACU_VE Dfrmry Cemﬁ«_:alc Sc:mces 1 Directory Services (AD LDS) provides
[ Active Directory Domain Services a store for application-specific data,

Features [[] Active Directory Federation Services for directory-enabled applications

that do not require the infrastructure

AD LDS I
" s E s of Active Directory Domain Services.

Confirmation [ Active Directory Rights Management Services Multiple instances of AD LDS can

[ Application Server - exist on a single server, each of

] DHCP Server which can have its own schema.

[] DNS Server

[[] Fax Server

» [m] File and Storage Services (1 of 12 installed)
O Hyper-v

[ Network Policy and Access Services
] Print and Document Services

[[] Remote Access

[} Remote Desktop Services |

[ <Previous | [ Ne> | | instal | [ cCancel

6. From the list of features, choose nothing — just click Next.

Select features O it

Before You Begin Select one or more features to install on the selected server.

Installation Type Features Description

Server Selection ) . T ST A .NET Framework 3.5 combines the
Server Roles e SEERIEERE=Y Tl power of the .NET Framework 2.0
b [E] .NET Framework 4.5 Features (2 of 7 installed) APIs with new technologies for
_ b [] Background Intelligent Transfer Service (BITS)  |= building applications that offer
AD LDS [¥] BitLocker Drive Encryption (Instalied) appicaing ey 1"t £ proEel
i . your customers' personal identity
Confirmation [ BitLocker Network Unlock information, enable seamless and
[] BranchCache secure communication, and provide
[] Ciient for NFS the ability to model a range of
business esses.
[[] Data Center Bridging s
(] Direct Play
[Vl Enhanced Storage (Installed)
[[] Failover Clustering
[] Group Policy Management
[C] 1S Hostable Web Core
] Ink and Handwriting Services -
-~ . i i, v
< " [ T3]

<Previous | [ Nea> | [ el | [ Cancel ]
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7. Click Next.

DESTINATION SERVER

Active Directory Lightweight Directory Services (AD LDS)  wwsasnauczmonsiocs

Before You Begin | Organizations that have applications which require a directory for storing application data can use
Active Directory Lightweight Directory Services (AD LDS) as the data store. AD LDS runs as a non-

Installation Type operating-system service, and, as such, it does not require deployment on a domain controller. Running

Server Salection as a non-operating-system service allows multiple instances of AD LDS to run concurrently on a single
server, and each instance can be configured independently for servicing multiple applications.

Server Roles

Features Things to note:

= After installing AD LDS, instances of AD LDS can be created by launching the AD LDS Setup Wizard
Confirmation | from the Advanced Tools section of the AD LDS home page.

* Before removing the AD LDS role, you must use Programs and Features in Control Panel to remove
all previously installed AD LDS instances.

<Previous | [ Net> | | nstal [ Cancel
|
8. Click Install to start installation.

Confirm installation selections NI oyl

Befora You Begin To install the following roles, role services, or features on selected server, click Install.

Installation Type [C] Restart the destination server automatically if required

Server Selection Optional features (such as administration tools) might be displayed on this page because they have

= been selected automatically. If you do not want to install these optional features, click Previous to clear

Server Roles Yhair thack |

Features

AD LDS Active Directory Lightweight Directory Services
_ Remote Server Administration Tools

Role Administration Tools
AD DS and AD LDS Tools

AD LDS Snap-Ins and Command-Line Tools

Export configuration settings
Specify an alternate source path

9. Once installation is complete, click Close.
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[ Add Roles and Features Wizard —[a] x

| o | P - g = DESTINATION SERVER
Installation progress

WIN-ISQION3LKT2. mxone.local

View installation progress

0 Feature installation

Configuration required. Installation succeeded on WIN-I5

Active Directory Lightweight Directory Services
To create a new AD LDS instance on this server, run the Active Directory Lightweight Directory
Services Setup Wizard. For more information, see http://go.microsoft.com/fwlink/TLinkld=224861.

Run the Active Directory Lightweight Directory Services Setup Wizard

.NET Framework 3.5 Features
NET Framework 3.5 (includes .NET 2.0 and 3.0)

Remote Server Administration Tools
Role Administration Tools
AD DS and AD LDS Tools
AD LDS Snap-Ins and Command-Line Tools

You can close this wizard without interrupting running tasks. View task progress or open this
B} page again by clicking Notifications in the command bar, and then Task Details.

Export configuration settings

Note: AD LDS Role is successfully set up. Create a new AD LDS Instance as “Instancel” using the
wizard.

10. Click the Run the Active Directory Lightweight Directory Services Setup Wizard shown in
the above screen and then click Close.

Note: This entire procedure implemented and documented based on Windows 2012 edition.

2.2 CREATING AD LDS INSTANCE

1. Open the Server Manager.

2. Inthe Console tree, select Roles - select Active Directory Lightweight Directory Services
from Roles Summary section.
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DESTINATION SERVER
Select server roles ..ol bbb
Before You Begin Select one or more roles to install on the selected server.
Installation Type Roles Description
Server Selection ive Di ; i
[] Active Directory Certificate Services ka3 gictwe ?;r::':g;:?:nm&'?s?t i
[] Active Directory Domain Services a store for application-specific data,
Features [] Active Directory Federation Services for directory-enabled applications
AD LDS Active Directory Lightweight Directory Services ﬂ;at do n::, mciu"t:'e mfm;:ufmm
of Active Directory Domain Services.
Confirmation I:I Active Directory Rights Management Services Multiple instam:e?ofAD LDS can
[] Application Server s exist on a single server, each of
] DHCP Server which can have its own schema.
] DNS Server
[] Fax Server
> [m] File and Storage Services (1 of 12 installed)
CJ Hyper-v

[ Network Policy and Access Services
] Print and Document Services

[] Remote Access

[[] Remote Desktop Services

<Previous | [ Net> | | insal || Cancel

3. Click Next> Next...until the AD LDS Role is successfully setup. Refer the step 9 and 10
of Enabling AD LDS in Windows Server.

4. Select A unique instance displayed in the Setup Options. Click Next.

Setup Options ‘
An AD LDS instance is created each time AD LDS is installed. O

You can create a unique instance, or you can install a replica of an existing instance.

Select the type of instance you want to install.

(® Aunique instance
This option automatically creates a new instance of AD LDS that uses the default

corfiguration and schema partitions. The new instance will not be able to replicate
with exdsting instances.

() Areplica of an exdsting instance
This option creates a new instance of AD LDS that uses the configuration and
schema partitions replicated from another instance of AD LDS. You can also select
the application partitions to replicate.

5. Enter the Instance name and Description. Click Next.
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ance Name ‘
The instance name is used to diferentiate this instance of AD LDS from other AD Q/
LDS instances on this computer.

Type a name for this instance. The name should reflect the use for which this instance
of AD LDS is intended.

Instance name:

Bxample: Addressbook 1

Description:
AD LDSinstance

The AD LDS service name is created when the instance name is combined with the
product name . It will be displayed in the list of Windows services, together with the
description you enter.

AD LDS service display name: instance
AD LDS service name: ADAM_instance1

6. Enterth

| <Back || Net> || Cancdl | | Hep

e LDAP port number and LDAPS SSL port number that should be accessed from

other applications to AD LDS; Or,

7. Click Next and continue with default ports.

Note: If
it chang
636.

Ports

you are installing AD LDS in the same server where Active Directory is installed, then
es the port series from 50000. Otherwise, it gives default LDAP/s port such as 389,

Computers will connect to this instance of AD LDS using specfic ports on all of the .
IP addresses associated with this computer.

The ports displayed below are the first available for this computer. To change these
ports, type the new port numbers in the text boxes below.

If you plan to install Active Directory Domain Services on this computer, do not use 389
for the LDAP port or 636 forthe SSL port because Active Directory Domain Services
uses these port numbers. Instead, use available port numbers from the following range:
1025-65535.

LDAP port number:

SSL port number:
50001
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8. Select Yes, create and application directory partition and enter the Partition name. Click
Next.

Application Directory Partition
An application directory partition stores application-specific data. 0

Do you want to create an application directory partition for this instance of AD LDS?

() No, do not create an application directory partition

Select this option if the application that you plan to install creates an application directory
upon installation, or if you plan to create one later.

(®) Yes, create an application directory partition
Select this option if the application that you plan to install does not create an application

directory partition upon installation. A valid partition name is any distinguished name that does
not already exist in this instance. Example distinguished name:
CN=Partition1.DC=Woodgrove . DC=COM

Partition name:
DC=wbmusersadidsdomain dc =com|

| <Back || Next>

File Locations
You can specify a location for each type of file associated with this instance of AD
LDS.

Specify the locations to store files associated with AD LDS.

Browse
Data recovery files:
C:\Program Files\Microsoft ADAM\instance 1'data Browse
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10. Choose Network service account for running the AD LDS Service.

AD LDS performs operations using the pemissions associated with the account
you select. /

Set up AD LDS to perform operations using the permissions associated with the following
account.

(®) Network service account
AD LDS has the pemmissions of the default Windows service account.

() This account:
AD LDS service has the pemissions of the selected account.

User name: | [ 5§

Password !

11. Select the below 3 LDF files from the Importing LDIF Files window.

Importing LDIF Rles
You can import data from Lightweight Directory Interchange Format (LDIF) files into
your AD LDS application directory partition.

To corfigure the AD LDS service in a specic way, import one or mare of the LDIF files listed

LDIF file name Description ~
[+ {MS-AdamSyncMetadata LOF ~ ADAMSync metadata schema extension. Required
[w] MS-ADLDS-DisplaySpecifiers L. AD LDS Display specffiers schema and display

[¥] MS-AZMan LDF AD LDS schema extensions for AzMan.

[ MS-netOrgPerson.LDF AD LDS inetOrgPerson, user and related classes.
[V MS-MembershipTranstive LDF  AD LDS memberhsip transtive.

[w] MS-ParentDistname LDF AD LDS parent dist name.

[v] MS-ReplValMetadatabxd LDF ~ AD LDS ReplValueMetaDataExt.

[ ibute Contml Acress Rihts
< m >

[ <Back | MNet> | [ Cancel | [ Hep |

e MS-InetOrgPerson.LDF
e MS-User.LDF
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o MS-UserProxyFull.LDF

12. Verify that all the selections are right and then Click Next to confirm Installation.

Ready to Install .
The AD LDS Setup Wizard is ready to install AD LDS with the following Q/
configuration.

Before continuing, review and corfirm your selections.

Selections:

MS-InetOrgPerson.LDF
MS-Membership Transitive LDF
MS-Parent Distname. . LDF
MS-ReplValMetadatabx LDF
MS-SecretAttributeCARs LDF
MS-SetOwnerBypassQuotaCARs . LDF
MS-User. LDF

MS-UserProxy. LDF
IMS-LbeeruyFtl.l.D-F

To change your selections, click Back. To install AD LDS, click Next.

| <Back [ Net>

Installing AD LDS ‘
The AD LDS Setup Wizard is installing AD LDS. Q/

installing AD LDS...
— |

Please watt while the wizard completes the following steps.
v Copied files
Importing LDIF file MS-ADAM-Upgrade-2idf ...

13. Once the instance is setup successfully, click Finish.
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Active Directory Lightweight Directory Services Setup Wizard -

."I
/

Completing the Active Directory
Lightweight Directory Services
Setup Wizard

You have successfully completed the Active Directory
Lightweight Directory Services Setup Wizard.

i Dashboard

# Local Server

& All Servers

E® ADCS

& ADDs

& DNS

#§ File and Storage Services b
o us

Server Name

WIN-ISQI9N3LKTZ
WIN-ISQI9NILKT2
WIN-ISQI9N3LKT2
WIN-ISQI9N3LKT2
WIN-ISQI9NZLKT2
WIN-I5QISNILKT2

SERVICES

+ Add crite

Server Nams

Manage  Tools  View Help
o - " ow -
Log
1161 Error ADAM [instance1] General ADAM (inst
1463 Waming ADAM [instancel] General ADAM (inst
614 Waming ADAM [instancel] ISAM ADAM (inst]
2886 Waming ADAM [instance1] LDAP ADAM (inst = it
1463 Waming ADAM [instancel] General ADAM (inst]
614 Waming ADAM [instancel] ISAM ADAM (inst o
W ;
TASKS ~
- H - ~
Start
2
Server 2012 R2

47/1553-ANF 901 15 A4 2019-11-29
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2.3 CREATING THE CUSTOM LDF FILE TO SUIT FOR AD LDS SETUP

1. Open Command Prompt - Go to C:\Windows\ADAM.

o} Administrator: Command Prompt

icrosoft Windows [Uersion 6.3.96081]
(c)> 2813 Microsoft Corporation. All rights reserved.

N\Users\Administrator>cd c:\Windows“\ADAM
z :\Windows\ADAM>ADSchemafAnalyzer.exe

s :\Windows\ADAM>

2. Execute ADSchemaAnalyzer.exe that displays a new window AD DS / LDS Schema
Analyzer.

] AD DS/LDS Schema Analyzer =E

File Schema Tools

3. In Schema Analyzer window, go to File Menu - select Load Target Schema.

. ] AD DS/LDS Schema Analyzer \;IE_
Schema Tools

Load target schema... Ctrl+T

4. InLoad Target Schema dialog box, provide the following details:

e Server[:port]: [Give IP address of Active Directory Server]:[Active Directory port]

47/1553-ANF 901 15 Uen A5 2019-11-29 12
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¢ Username: [Username to connect to Active Directory]
e Password: [Password of above username of Active Directory]

¢ Domain: [Domain of Active Directory which contains above user]

[10.211.159.143

|mxone]
Bind type (¢ Secure " Simple

Server lype
& Auto

" AD DSILDS
" Generic (subschemaSubentry)

Load LDIF... I Ok

Note: If you do not provide port number after server IP/DNS Name, it takes default LDAP port
that is 389.
Click Ok.

AD DS/LDS Schema Analyzer screen shows the following folder structure. Once it is
connected to Active Directory Server.

File Schema Tools

[#-{_] Classes
@ Attributes
[ Property sets

Loaded schema: 1472 attributes, 264 classes, 80 property sets. []

7. Goto File Menu = Load base schema.

47/1553-ANF 901 15 Uen A5 2019-11-29
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47¢ Favorites

B Desktop

o o . . | File | Schema Tools
Load target schema... (<31 Q| Classes
Load base schema... Ctrl+B Property sets
Create LDIF file... Ctrl+L

Exit

A& .. B -

8. The Load base schema dialog box appears to enter the following details:
e Server[:Port]: [Give IP address of AD LDS]:[AD LDS port]

e Username: [Administrator Username of the local server]

e Password: [Password of Administrator]

e Domain: [Domain of Active Directory which contains above user]

] AD DS/LDS Schema Analyzer - o] x
File Schema Tools

#-{_] Classes
-] Attributes
&3] Property sets

Server[:porf] |10.211.159.143.5000d
Username |admir|istritor

Bind type % Secure ¢ Simple

Server type
& Auto
" AD DSILDS

" Generic (subschemaSubentry)

Load LDIF... | Cancel |
IValidatina schema... ~

9. Click OKk.

10. Go to Schema Menu - select Mark all non-present elements as included.

11. Click Ok.

File | Schema | Tools
@ Hide present elements

E E] Show present elements

| Mark all non-present elements as included

Loaded schema: 1472 attributes, 264 classes, 80 property sets. |
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12. Go to File Menu = select Create LDIF file.

;] AD DS/LDS Schema Analyzer \;‘E-
Schema Tools

Load target schema... Ctrl+T
Load base schema... Ctrl+B
Create LDIF file... Ctrl+L
Exit
[Loaded schema: 1472 attributes, 264 classes, 80 property sets ~

13. In the File Dialog box provide the path of LDIF file to store.
14. By default, it shows C:\Windows\ADAM Path.

15. Enter name of the file and click Save.

16. Open Command Prompt = Go to C:\Windows\System32.
17. Execute the following 3 commands as mentioned below:

e |difde -i -u -f [Path of LDIF File which is created by using Schema Analyzer] -s [IP
address of AD LDS]:[Port of AD LDS] -b [Administrator Username of the local server ]
[Domain of Active Directory which contains above user] [Password of Administrator] -j
. -¢ "cn=Configuration,dc=X" #configurationNamingContext

For example,

[difde -i -u -f c:\windows\adam\ADLDSSyncProxy3_129.Idf -s 192.168.26.129:50000 -
b administrator pmsnmdomain XXXXXXXXXXXXXX -j . -c "cn=Configuration,dc=X"
#configurationNamingContext

6] Administrator: Command Prompt \;‘E-

icrosoft Windows [Uewrsion 6.3.960@1 N
(c) 2013 Microsoft Corporation. All rights reserved.

N\UsersSAdministrator?cd c:\Windows\System32

\Users\System3d2>1difde —i —u —f c:\Windows\ADAMMADLDSSyncProxy3_142.14f -
10.211.159.143:50000 -b administrator PRI SEETEIETE -j . —c “'cn=Conf iguratio
~dc=k" HconfigurationNamingContext

onnecting to "10.211.159.143:50888"

Logging in as “administrator"” in domain "mxone" using SSPI
Importing directory from file "c:\Windows:\ADAMNADLDESyncProxy3_143.1d4df"
Loading entries...

¢ [difde -i -f c:\windows\adam\MS-AdamSyncMetadata.ldf -s [IP address of AD
LDS]:[Port of AD LDS] -b [Administrator Username of the local server ] [Domain of
Active Directory which contains above user] [Password of Administrator] -c
CN=Configuration,DC=X #ConfigurationNamingContext
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For example,

Idifde -i -f c:\windows\adam\MS-AdamSyncMetadata.ldf -s 192.168.26.129:50000 -b
administrator pmsnmdomain XXXXXXXXXXXXXX -¢c CN=Configuration,DC=X
#ConfigurationNamingContext

o] Administrator: Command Prompt \;‘E-

icrosoft Windows [Uersion 6.3.96801]
(c?» 2813 Microsoft Corporation. All rights reserved.

:N\UsersSAdministrator?>ldifde —i —f c:\Windows“ADAM\MS-AdamSyncMetadata.LDF -s 1
.211.159.143:50008 -b administrator DI EEEEITE ¢ CN=Configuration,.DC=X HC
onfigurationNamingContext

onnecting to '"10.211.15%.143:568088"

Logging in as “administrator' in domain "mxone' using SSPI

entries modified successfully.

he command has completed successfully

o l|difde -i -f c:\\windows\adam\MS-adamschemaw?2k8.Idf -s [IP address of AD LDS]:[Port
of AD LDS] -b [Administrator Username of the local server ] [Domain of Active
Directory which contains above user] [Password of Administrator] -c
CN=Configuration,DC=X#ConfigurationNamingContext

For example,

Idifde -i -f c:\windows\adam\MS-adamschemaw2k8.ldf -s 192.168.26.129:50000 -b
administrator pmsnmdomain XXXXXXXXXXXX -c
CN=Configuration,DC=X#ConfigurationNamingContext

NUsers\Administrator>cd c:\Windows\System32

\Windows\System32>1difde -i -f c:\Windows“\ADAM\MS-AdamSyncMetadata.LDF -s 160.2
11.159.143:58800 -b administrator mxone MitelP123 -¢ CN=Configuration,.DC=X #Conf
igurationNamingContext

onnecting to "10.211.159.143:500088"

Logging in as "administrator" in domain "mxone' using SSPI

[mporting directory from file "c:\Windows\ADAM\MS-AdamSyncMetadata.LDF"

..................................................................

1208 entries modified successfully.

he command has completed successfully

\Windows\System32> v

2.4 RESTARTING THE AD LDS INSTANCE

1. Select Server Manager - Roles = Active Directory Lightweight Directory Services.
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2. Check for System Services section that is displayed in the right-side pane.

SERVICES

Stop Senaces

Restart Services.

WIN-ISCENILKT =3 ADAM instancel

Telal o e mMim]z]

Server 2012 R2

3. Select the AD LDS Instance Name and right click on the AD LDS instance, select

Restart/Stop — Start.

2.5 CREATING AN ADMIN USER IN AD LDS

1. Select Server Manager—->Roles—>Active Directory Lightweight Directory Services.

2. Select ADSI Edit shown in the right side pane, under the Advance Tools section.

[ Server Manager =18

«“ AD LDS
— - Active Direciary Administrative Center
WIN-SQIONGLET2 10211150143 Onfine - Performance cou Active Directory Domaing and Trusts

Faikover Cluster Manager

7 Waming

WIN-ASQIONILKT2 2537

Group Pokicy Management
Warning

WIN 19NILKT2 1161 Error Internet Infarmation Sensces (II5) Manager
WIN 72 1463 Warning ISCSI Initator
WIN-SOINILKT2 614 Waming ADAM [instance] I5AM Local Security Policy
] OD2C Data Sources [32-bit)
OOBC Data Sources (64-bat)
Performance Monitor

SERVICES Resource Maritor
— Securily Canfiguration Wissed

2 v (A= Services

i Dashboard Aetive Dirsctory Lightweight Directory Senvices Setup Wizard
i Local Server Active Dirsctory Module for Windows PowerShell
B Al Servers Active Directory Setes and Services
" ADCS | Active Directory Users and Computers
HE = ADS! Edit
LS Centification Authority
i e Ui
g’ DNS _EVENTS Compaonent Services
B§ File and Storage Senices P - . Computar Managemant
o s e B I - " w Defragment and Optimize Drives
Disk Cleanup
DNS
Event Viewer
VIN-ISCHINILKT, Warning ADAM

Internet Infiaerabon Sences (1IS) 6.0 Manager

elal ¢ Hm]

T
= EED gy

3. In ADSI Edit window, go to Action Menu, select Connect to... option, or right click on ADSI

Edit in the left side pane.
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File Action View Help

PG RS

B"_| TR ] 59.143:50000] ';.:I:Ll}spfmySyncnﬂ.Zﬂ,... :.I::mmus "-- PR
View » 211.159.143:50000] & Default naming context [10.... domainDNS "
| Refresh 1211,159,98:389] i Default naming contest [10.... domainDNS Mare Actions
Export List...
Help

4. The Connection Settings window appears to fill the below details.

Name: | Default naming context |

Path: | LDAP://10.211.159. 143:50000/DC =wbmusersadidsdomain,dc=|

Connection Point
(®) Select or type a Distinguished Name or Naming Context:
|DC=nh1mersacldsdomah,dc=com vl

(O select a well known Naming Context:

| Default naming context v

Computer
(®) Select or type a domain or server: (Server | Domain [:port])

v]

(O Default (Domain or server that you logged in to)
[]Use 55L-based Encryption

Adyanced... | ok | | cancl

Enter Name to identify this AD LDS Instance.

In the Connection Point section, Select or type Distinguished Name or Naming Context
and enter the Partition Name in AD LDS instance.

7. Inthe Computer section, Select or type a domain or server: (Server | Domain[:Port]) and
enter the server IP of AD LDS and port details.

8. Click OK. The following ADSI Edit window appears.

File Action View Help
e 2m o= BE

z ADSI Edit Name Class Distinguished Name
§ AD LDS Proxy Sync [10.211.159.143:50000] [ DC=pmsnm,DC=com domainDNS DC=pmsnm,DC=com
i Default naming context [10.211.159.143:50000]
4| 5 Default naming context [10.211.159.98:389] |
] DC=pmsnm,DC=com

9. In ADSI Edit window, you can expand the right side pane to check Name and Distinguished
Name.
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10. Right click on Partition/ Distinguished Name - select New > Object.
11. In Create Object window > select container from the class list provided below.

Z ADSI Edit = (Bl
File Action View Help

e 2@ XE G =

2‘ ADSI Edit ed Name Actions
& ADLDS Proxy Sync [10.211.159.143: . hek,DC=pmst -
& Default naming context [10.211.159, Sl DC=pmsnm

4 i Default naming context [10.211.159, - == b uters, DC=prr] More ... »
| DC=pmsnm,DC=com 7~ <
<3 = P i dassStore E in Controllers
| OU=Abhishek computer Sreek
=) CN=Builtin contact gnSecurityPrin
g k DC=pmsnm
S CH=Compatut counkry ndFound,DC=
] OU=Domain Controllers device ‘ e
] CN=ForeignSecurityPrincipa ook akion 9
x domainDNS Quotas,DC=¢
[] OU=Karthik domainPolicy N ’DC
(7] CN=LostAndFound friendlyCountry mDataDC=
(] CN=Managed Service Accor L ,DC=pmsnm,
[] CN=NTDS Quotas New,DC=pm:
] CN=Program Data 0U,DC=pmsr
] OU=Satish ,DC=pmsnm,
[] OU=SatishNew DC=pmsnn
[] OU=SatishOU C=pmsnm,D(
[7] OU=Sunny Devices,DC=p|
[7] CN=System 1 CN=Users container CN=Users,DC=pmsnm,[

12. Click Next. The Create Object window appears to add value.

13. Enter name of the container in the Value box. For example, ADLDSAdminUsers and click
Next.

Attribute: m

Syntax: Unicode String

Description: Common-Name

Value: ADLDSAdminUsers|

| <gsck || mext> || concel || reb |

14. Click Finish.

15. Right-click on the newly created container which is added under the Partition Name and
select New > Object.
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i AD LDS Proxy Sync [10.211.159.143:50000]
i Default naming context [10.211.159.143:50000]
d i Default naming context [10.211.159.98:389]
4 ] DC=pmsnm,DC=com
] OU=Abhishek
] CN=Builtin
[7] CN=Computers
| ] OU=Domain Controllers

There are no items to show in this»

[ ] CN=ForeignSecurityPrincipals

7] OU=Karthik Move

(1 CN=LostAndFound New Connection from Here

[ CN=Managed Servi

] CN=NTDS Quotas || New » [ Object.. ”
[ 7] CN=Program Data View :
(] OU=Satish I -
(] OU=SatishNew Delete

[] OU=SatishOU Rename

7] OU=Sunny Refresh

] CN=System Export List...

(7] OU=test -

[] CN=TPM Devices | Properties

[2] CN=Users Help

[ CN=ADLDSAdminUsersT ”

16. In the Create Object window, select user from the list of Class items displayed. Click Next.

Select a dass:

rRASAdministrationConnectionPoint
rRASAdministrationDictionary
samServer

secret

serviceAdministrationPoint
serviceClass
serviceConnectionPoint
servicelnstance

storage

trustedDomain

17. Enter a username (for example, adldsadmin) in the Value box.

value: | adidsadmin|
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18. Click Next - click Finish.

19. Expand newly created container and right click on the newly created user. The following
window appears to Reset Password.

[%5] CN=adldsadmin jicer CMN=adldsadmin,C

Move

New Connection from Here

| Reset Password... |

New >

Delete
Rename
Refresh

Properties

Help

20. Select Reset Password. The following window appears to assign a new password for user.

Reset Password [x]

l EXEEXXEEE

New password:

Confirm password:

l :tttuttli

The account must log off and then log on again for the change to take

effect.
OK | Cancel

21. Enter the New password and Confirm password. Click OK.

22. Right click on the newly created user and select Properties.

5] CN=adldsagaic dsadmin, CN=4

Move

New Connection from Here

Reset Password...

New »

Delete
Rename

Refresh

Properties

Help

23. Right click on the newly created user properties dialog, select displayName and double click
on it. The following String Attribute Editor appears.
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CN=adldsadmin Properties

Jstinguisk
Astute Edlor [0 N=adids:

facsimile TelephoneN... <not set>

flags <not set> ™
<] T
| Bter |

displayNamePrirtable  <not set>
distinguishedName CN=adldsadmin. CN=ADLDSAdminUsers, DC:

division <nof sed

[<] n | >
Lok || Concel || ooy || Heo |
26. Click OK.

27. In the same attribute editor Select msDS-UserAccountDisabled and double click on it. The
following Boolean Attribute Editor window appears.
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CN=adldsadmin Properties

? x

Attribute Editor

Aftributes:

Attribute
msDS-HABSeniorityln...
msDS-PhoneticComp...
{ msDS-PhoneticDepar...
msDS-PhoneticDispla...
g msDS-PhoneticFirstN....
msDS-PhoneticLastN...
msDS-PrimaryComputer
msDS-Site-Affinity
msDS-SourceObject DN
msDS-SupportedEncr...
msDS-SyncServerUd
msDS-UserAccountDi...
msDS-UserDont Expir...
ms-DS-UserEncrypte...

e

28. Select False and click OK.
29. Click Apply = OK.

msDS-UserAccount Disabled

30. Expand the newly created partition name and CN=Roles. Right click on
CN=Administrators>Properties to view the Attribute Editor.

Z ADSI Edit
4 [ ADLDS Proxy Sync [10.211.155.143:50000]
4 | DC=wbmusersadidsdomain,dc=com
] CN=LestandFound
] CN=NTDS Quotas

| Name Cl

There are no itemns to show in this

view.

4[] CN=Roles
B :
O CNeRead  Move
" CN=Usen New Connection from Here
4 CN:ADI.DSﬁ' New »
] CN=adidy
& Default naming conl View i
i Default naming cent Delste
& Default naming cont L
Refresh
Export List...
| Properties |
Help

Mere Actions. L3

31. In the Attribute Editor, select member and click Edit.
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isCriticalSystemObject  TRUE
labeledURI <not set>
lastKnownParent <not set>
legacyExchangeDN <not set>
managedBy <not set>
CN=Administrators CN=Roles CN=Configurati
memberlid <not set>
msDS-AzApplicationD. . <not st
msDS-AzBizRule <not set>
msDS-AzBizRulelang... <not set>
msDS-AzGenencData  <not set>
msDS-AzLastimporte...  <not set>
msDS-AzLDAPQuery  <not set>
mS-DS-ConsistencyC.. <not sets Iz
<1 m | B
[ ok |[ Cancel || apy |[ Hep |

32. Click Add DN button - Enter DN of user created above (for example,
CN=adldsadmin,CN=ADLDSAdminUsers,DC=wbmusersadldsdomain,DC=com) -> click

OK.
Multi-valued Distinguished Name With Security Principal Editor -
Attribute: member
Values:
Name Container Distinguished Name / SID
Administrators [{3F4B7CE3-7285-4C60-A9D2-0514813AB5...  CM=Administrators,CN=Roles,CN...

Enter a distinguished name (DN) for an object.
JSAdminUsers,DC =wbmusersadidsdomain,DC=com| |

33. Click OK -> click Apply - click OK.
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2.6 CHECKING USER AUTHENTICATION

1. On the Start Menu, click Run. The following Run program window appears.

Type the name of a program, folder, document, or Internet

@ resource, and Windows will open it for you.

gpen || ;

@ This task will be created with administrative privileges.

2. Type Idp.exe (Label Distribution Protocol) in the Run box and click OK to open Ldp.exe
window.

3. In LDP window = Go to Connection = Connect.

| Connection | Browse View Options Utilities Help

| Connect...

Bind... Ctrl+B

Disconnect

New Ctrl+N
Save
Save As

4. Enter the IP Server address and Port number of AD LDS Instance - click OK.

Server: | [FSFRECRLE

port: [ 50000 |

5. Goto Connection - Bind. The following Bind window appears.
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adldsadmin

mxonedomain

Bind type
() Bind as currently logged on user

() Bind with credentials

(® Simple bind

(O Advanced (DIGEST)

|| Encrypt traffic after bind

! Advanced I Cancel | | OK |

To connect and bind the server that hosts the forest root domain of your AD DS environment.
Enter the following details:

e User: [username which is created above]
e Password: [Password of the above user]
o Domain: By default, remains in deactivate mode
e Bind Type: [select Simple bind]
6. Click OK.
Note: The user must be an authenticated user as mentioned in the above screen.

An example of successful authentication is given below.

res = Idap_simple_bind_s(ld, 'adidsadmin', sunavailable=]; w3
Autherticated az: 'Ch=adldzadmin CR=ADLDSAdminUsers DC=whimuzersaddsdomain DC=com'.

2.7 ADDING ATTRIBUTES TO USERPROXYFULL CLASS

1. On the Start Menu, type MMC, and then click OK. The following Console window appears.

& File Action View Favorites Window Help

e @ = BmE

) Console Root Name

There are no items to show in this view.

2. Goto File menu - click Add/Remove Snap-in.
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File | Action View Favorites Window
@ |New Ctri+N
o Open.. Ctrl+0

Save Ctrl+S

Save As...
| AddRemoveSnap . CieM

Options...

.1adsied'rt

2 lusrmgr

.Exit

3. Select Active Directory Schema - click Add - OK.

You can select snap-ins for this console from those available on your computer and configure the selected set of snap-ins. For
extensible snap-ins, you can configure which extensions are enabled.

Available snap-ins: Selected snap-ins:
i Vendor |~ (I Console Root
. Microsoft [& Active Directory Schema
Microsoft C =
[#§¥ Active Directory Sites and ... Microsoft
] Active Directory Users and... Microsoft C
= ActiveX Control Microsoft C :
2 ADSI Edit Microsoft C Move Down
Aulhorizaﬁon Manager Microsoft C
5 Certificate Templates Microsoft C
(3 Certificates Microsoft €
L5 Certification Authority Microsoft C
. Component Services Microsoft C
A Computer Management Microsoft C
nsn&c v]

Move Up

[« m

Description:
View and edit the Active Directory Schema

4. Right click on Active Directory Schema and select Change Active Directory Domain
Controller.
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ﬁ Eile Action View Favorites Window Help

e« snm o= BE

| Console Root H Name

3 [3 Active Directory S¢ o — -
; 7_] Change Active Directory Domain Controller...

Connect to Schema Operations Master
Operations Master...

Permissions...

Reload the Schema

View »
New Window from Here

New Taskpad View...

Refresh
Export List...

Help

5. Select This Domain Controller or AD LDS instance.
Current Directory Server:
WIN-I5Q19N3LK72 mxone Jocal

Change to:
) Any writable Domain Controller
(®) This Domain Cortroller or AD LDS instance
Look in this domain: mone local v

Name Site DC Type DC Version Status

WIN-I5QISN3LK72 mxone local Default-First-Ste-Name  GC Windows... Unavailable

6. Enter IP Address of the AD LDS Instance with port number and click outside of the
highlighted edit area. The Status column value changes to Online.
Change to:
O Any writable Domain Controller
(®) This Domain Controller or AD LDS instance
Look in this domain: |rrmoneJocal V]

(® This Domain Cortroller or AD LDS instance

Look in this domain: |rmwne.local V|
Name Site DC Type DC Version Status
10.211.159.1 D00 Online

7. Select this entry (that is, anywhere outside from the edit section) = click OK - click Yes.
8. Expand Classes to select the required attributes displayed in the Classes list.
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'°]|l

ﬁ File Action View Favorites Window Help

e 27 6= HE

[ | Console Root A I| Name
4 &, Active Directory Schema = ||| "] Classes
4 Classes l| £ Attributes

®rs account
B2 aCSPolicy
8= aCSResourcelimi
Sr= aCSSubnet
% addressBookCon'
9% addressTemblate

9. Select userProxyFull from the Classes list and right click on it to select Properties.

Idapy//WIN-{5QI9N3LK72 myone Jocal50000/ L= |T| X |

sction  Browse View Options  Utilities Help
(POLICY_HINTS }; 1.2, 840, 112555 1,4 2255,

Eﬁh Action  View Favorites Window Help

% 2m B¢z B

52 shadowAccount ~ [ Mame Type Sytem  Description
B2 simpleSecurityObject L defaultClassStore Optional  Ves Default-Class-Store |
B3 site " dynamicLDAPServer  Optional  Yes Dynamic-LDAP-Server
=13 sitelink & lastLogonTimestamp ~ Optional Yes Last-Logon-Timestamy
:E s.dd.mlr.ﬂrn.ige L« prefemredOU Optional ~ Yes Preferred-0U
R skesContainer 1" userParameters Optional ~ Yes User-Parameters
.f: m:‘r o, userPrincipaiName Optional Yes User-Principal-Name
i :h: s 1" userCertificate Optional Vs A509-Cert
.:E e e 1" businessCategory Optional ~ Yes Business-Category
:f: syncEngineAuxConfiguration 5:‘:;:““ g:::: :: r:::"“'""n"m
.E ::En?mwobﬁd Emo'rl Optional Yes E-mail-Addresses
E 2 trustedDomain [ manager Optional  Yes Manager

%2 typelibrary [ mebile Optional  Yes Phone-Mobile-Primar,
B2 user o Optional Yes Organization-Name
'D[: " — 1| 1s" pager Optional Yes Phone-Pager-Primary
7 volume View ¢ |audio Optional  No The Audio attribute tyg

L Axtributes New Window from Here carlicense Cptional o Vehicle license or regis

< i New Taskpad View... . Identifies 2 dr.nmme:ﬂ i
“| Opens the properties d Refresh
Export List...

B - l

10. Go to Attributes tab and check for the sAMAcountName attribute. If SAMAcountName
attribute is not available, then click Add button to include it to the Schema Object list.
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roomNumber

uid
userCertificate
userParameters
userPKCS12
incipalName

x500uniqueldentifier

Al E

secretary 1=

=

v |

11. Select sAMAccountName - click OK - click Apply - click OK.

userProxyFull Properties

? X

schemalDGUID
schemalnfo
schemallpdate
schemaVersion
scopeFlags
|scriptPath

searchflags

sDRightsEffective

In the same way, you can check and add the below attributes:

e objectSID

e SN
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e department

e location

e whenChanged

e telephoneNumber

¢  wWWWHomePage

e description

e physicalDeliveryOfficeName

o url

e streetAddress

e postOfficeBox

o | [Locality-Name]
e st

e postalCode

e C [Country-Name]
e profilePath

e scriptPath

o title

e company

o facsimileTelephoneNumber

e otherFacsimileTelephoneNumber
e msExchAssistantName

e roomNumber

e ipPhone

e objectClass

e objectCategory

e lastAgedChange

12. Restart AD LDS Instance when all the required attributes are added and checked.

2.8 EDITING OBJECT (USERPROXYFULL) CLASS AS USER OBJECT
CLASS

1. Inthe ADSI Edit Console tree, click ADSI Edit node - Click the Action menu > select
Connect to. The Connection Settings dialog box appears.
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Name: | ADLDDSSynchPoxy 1Schemal

Path: | LDAP:/f10.211. 159. 143:50000/Schema

Connection Point
() Select or type a Distinguished Name or Naming Context:

(®) Select a well known Naming Context:

| Schema

Computer

(®) Select or type a domain or server: (Server | Domain [:port])
| 10.211.159.143:50000

) Default (Domain or server that you logged in to)

[]Use ssL-based Encryption

In Connection Point section, click Select a well known Naming Context radio button.

In Computer section - select or type a domain or server: (Server | Domain [:port]) of AD
LDS Instance.

Select Schema from the drop-down list.

5. Expand Schema from left side pane - expand
CN=Shema,CN=Configuration,CN={XXXXXXX}.

File Action View Help
ICEE EEEN =

Z ADSI Edit
4 i Default naming context [10.211,159.98:389]
b ] DC=pmsnm,DC=com
4 i ADLDDSSynchPoxy1Schema [10.211.159.143:50000]
b || CN=Schema,CN=Configuration, CN={9F809790-2BBA

6. Select CN=User - right-click on it and select Properties.
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] CN=UPN-Suffixes H

| CN= M
] CN=U ove
5] CN=U New Connection from Here
B ON=U | New ’
[ CN=U I
E oon=y | View :
7] CN=U Delete
g CN=U Rename
CN=U
| CN=U Refruh‘
1 cN=U| Export List...
3 CN=U1| Properties
|:] CN=u |
B oN=u|__ |HelP

7. Select IDAPDisplayName and double click on it to modify the selected attribute value.

Value B
. D{OA:CR:ab721a53-1e-11d0-9819-00=al

<not set>
<not set>
<not set>
<not set>
<not set>
<not set>
<not set>

audio; carlicense; departmentNumber; displz
. <not set>
. <not set>
<not set>
CN=Class-Schema CN=Schema CN=Corfigu .,

| >

8. Change value to userADLDS (this is just a dummy name) - click Apply - click OK.

In the same way, you can change the IDAPDisplayName value of user-Proxy-Full to user.
Once the changed attribute value is applied, you must restart AD LDS Instance.
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CN=User-Principal-Name H
CN=User-Proxy-Eull

| CN=User-Share Move
| CN=User-Share New Connection from Here
| CN=User-SMIM
~| CN=User-Work New '
| CN=userClass View .
~ CN=userPKCS1 Delete
| CN=USN-Chan
| CN=USN-Creatf ~  Rename
~| CN=USN-DSA- Refresh
| CN=USN-Inters Export List...
CN:.USN~Last-|‘ =
~| CN=USN-5ourc
] CN:Valid-Acca: Help
CMN-=Vendar i

9. Change itto user - click OK - click Apply = click OK.

String Attribute Editor -
Atribute: |IDAPDisplayMName
Value:
= |
Clear oK || Cancel |

2.9 MODIFYING MS-ADAMSYNCCONF FILE

1. Go to C:\Windows\ADAM Directory in windows - Copy and Paste MS-AdamSyncConf.xml
file > Rename the newly created file (for example, MS-AdamSyncConf_Document.xml).

71| ADLDSSyncProxy_143 2/13/20196:14AM  LDF File 1,895 KB
M This PC | Idif.err 3 ERR File 1KB
b L Desktop 7 LDF file LDF File 2KB
b £l Documents | WBMSync Text Document 2KB
b @ Downloads 2’ MS-AdamSyncConf_Doc XML Document 3KB
b Music _-MS-AdamSynr_Cunf'l Text Document 3KB
b &) Pictures | ADLDSSyncProxy5_143 3KB
b @ Videos (%] adammsg.dll Application extens 4KB
b iy Local Disk (C:) | ] adamntds.dit DIT File 4112K8

2. Open the file in Edit mode (using Notepad) and modify below fields.
<source-ad-name>Domain Name of Active Directory</source-ad-name>
<source-ad-partition>Partition Name of Active Directory</source-ad-partition>
<source-ad-account>[user name of Active Directory Admin]</source-ad-account>
<account-domain>[Above Username Account Domain]</account-domain>
<target-dn>[DN/Partition in AD LDS]</target-dn>

<base-dn>[DN of users from which we want to synchronize from Active Directory]</base-dn>

For Example:
<source-ad-name>pmsnmdomain.com</source-ad-name>

<source-ad-partition>dc=pmsnmdomain,dc=com</source-ad-partition>
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<source-ad-account>administrator</source-ad-account>

<account-domain>pmsnmdomain</account-domain>

<target-dn>DC=wbmusersadldsdomain,dc=com</target-dn>
<base-dn>0OU=WBMUSers,DC=pmsnmdomain,DC=com</base-dn>

3. Save the modified file.

2.10 SYNCHRONIZING USERS FROM ACTIVE DIRECTORY TO AD LDS
INSTANCE

1. Open Command Prompt = Go to C:\Windows\ADAM.
2. Execute the following 2 commands as mentioned below.

e adamsync.exe /install [AD LDS Instance IP:Port] [MS-ADAMSyncConf.xml File Name]
/passprompt

For example: adamsync.exe /install 192.168.26.129:53986 MS-AdamSyncConf_Docuent.xml
/passprompt

Note: To synchronize users from Active Directory to AD LDS Instance, you must run the
Adamsync.exe utility.

3. Enter the password of Active Directory user which is mentioned in the XML file.

C: Mindows \ADAM>adansync .exe ~install 192.168.26.129:56600 MS—idamSyncConf_Docum
ent . XML /passprompt
Pleasze enter password:

Done .

C:sMindows~ADAM> _

e adamsync.exe /sync [AD LDS Instance IP:Port] "[DN/Partition Name of AD LDS]" /log
[Log File Name]
For example: adamsync.exe /sync 192.168.26.129:53986
"DC=wbmusersadldsdomain,dc=com" /log WBMSync.log
sHindows™

sWindows f
»Mindows AM>adamzync.exe ~ssync 192.168_.26_129:58008 ""DC=ubmuzerzadldszdomain.

HBMS ync - log

Note: WBMSync.log contains the user synchronization information from Active Directory to AD
LDS. If any issues occurred while synchronization, it gets recorded in this log. All the users get
synchronized from the Container to AD LDS except their passwords. So, you need to wait until
the user synchronization process is completed.
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2.11 CHECKING SYNCHRONIZED USERS IN AD LDS

1. Open Server Manager > expand Roles - select Active Directory Lightweight Directory
Services.

2. In Advanced Tools section - select ADSI Edit that is displayed in the right side pane.

3. In ADSI Edit window, go to Action menu - select Connect to, then provide the below
details.

4. In Connection Point section, click Select or Type Distinguished Name or Naming Context
- enter Partition Name.

10. In Computer section, click Select or type domain or server: (Server | Domain [:Port]) of
AD LDS Instance.

(Enter the IP address of AD LDS server with port number, for example:
192.168.26.129:50000).

. ADSI Edit
4 5| AD LDS Proxy Sync [10.211.159.143:50000]
4 | DC=wbmusersadldsdomain,dc=com

| CN=ADLDSAdminUsers

| Ch=LostandFound

| CH=NTDS Quatas

| CN=Raoles

= | OU=WEBM_lISers

| CN=Bisht.Neema
| CM=LN'3.Test1'z
| CN=Prasad.Sham
| CN=RajK.Dev
il OU=Sub\WEMUsers

All the Active Directory Users of that particular container and sub-containers gets
synchronized and visible under the ADSI Edit Console tree.

2.12 ENABLING LDAPS (SSL) FOR AD LDS IN WINDOW SERVER

Create a separate directory in the user location in the system.
2. Create afile adlds_request.inf (file name can be anything with .inf extension).
Copy the below highlighted content in that file and change the required value in pink color.

Note: Remember that “;” is a comment in this file.
[Version]
Signature="$Windows NT$"

[NewRequest]

Subject = [EHINIQUSNGCHNERMEIGHABIIDSISENER ; replace with the FQDN of the DC

KeySpec =1

KeyLength = bitsize can be any value from below line values
; Can be 1024, 2048, 4096, 8192, or 16384.

; Larger key sizes are more secure, but have

47/1553-ANF 901 15 Uen A5 2019-11-29



Configuration of AD LDS — User Guide

; a greater impact on performance.
Exportable = TRUE
MachineKeySet = TRUE

SMIME = False
PrivateKeyArchive = FALSE
UserProtected = FALSE
UseExistingKeySet = FALSE
ProviderName = "Microsoft RSA SChannel Cryptographic Provider"
ProviderType = 12

RequestType = PKCS10
KeyUsage = Oxa0

[EnhancedKeyUsageExtension]

0OID=1.3.6.1.5.5.7.3.1 ; this is for Server Authentication

4. Execute the below command in directory to create a certificate request.
certreq -new <.inf file name> <certificate request file name>

An example of the command is mentioned below.

c:\Certificates“\ADLDE_Certs“ADLDS_Keystore Dir>certreq —new Certificate_request_details.inf ADLDE_Request file.reg

c:\Certificates\ADLDS_Certs \ADLDS Keystore Dir>

5. Anew file is created in the same directory.

wCertificates ADLDE_Certs~ADLDS_Heystore_ Diridir
Uolume in drive C haszs no lahel.
Uolume Serial Wumber iz 3ACH-3200

Directory of c:Certificates~ADLDS_Certs“ADLDS_Keystore_Dir

1-11-2816 G5:40 AM <DIR> .
1s11,2016 @5:48 AM <DIR> .
11120816 @5:48 AM 1,388 ADLDS_Request_file.req
1-.11-2816 B82:19 AM 763 Certificate_request_details.inf
2 File<s> 2.143 hytes
2 Divdsd 6,.852,.823,.848 hytes free

nCertificates ADLDE_Certs~ADLDS_HKeystore_Dirl

6. Share the file with Certificate Authority to provide the signed certificate.
7. Copy the file in the same directory (with preferred extension of .cer / .crt).

For example, the sample AD LDS Server Signed Certificate (in this pmsnmdomain.com is
root certificate), which is certificate of Issuer who has issued certificate to AD LDS Instance.
Adldsserver.pmsnmdomain.com — is the Signed Certificate of AD LDS Instance.
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Certificate

General | Details Certification Path |

r— Certification path

3 pmsnmdamain.com
)

ser . pmsnmdomain. com

Wiews Certificate |

Certificate status:

This certificate is Ok,

Learn mote about certification paths

Once you receive the signed certificate from Certificate Authority. Type the below mentioned

command.

certreq -accept <received signed certificate file name>

An example of the command is mentioned below.

c=“Certificates“ADLDE_Certs~ADLDS_Keystore_ Dirlcertreq —accept ADLDS_Cert_Response.cer

c:\Certificates\ADLDS_Certs\ADLDS_Keystore Dir>

Open Command Prompt and Run as Administrator.

. In the command prompt, execute mmc command that opens a new mmc window.

. In the mmc window - go to File > select Add/Remove Snap-in option.

= Console1 - [Console Root]

_ﬂ File Action  Wiew  Faworites  wWindow

@3 Mew k4R
—  Open... Chrl+O
Save CLrl+5

Save As...

add/Remove Snap-in. .. k|1

Options...

. In the Add or Remove Snap Ins window, select Certificates from the left side pane and click

on Add button.

. Select Computer Account - click Next &> select Local Computer - click Finish = click

OK.

Thiz znap-in will alwars manage certificates for:
£ My uzer account
" Service account

* Computer account
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14.

15.
16.
17.

18.

19.
20.

21.
22.
23.

Extract Certificates - Personal - Certificates from the left side pane. All the certificates
get listed in the right side pane.

= Consolel - [Console Root' Certifics

& File  Action  Wiew Favorites
AR N ERNERESE 7|

| Cansole Roaok
= H Certificates (Local Computer)

El [ Personal

| Certificates
|| Trusted Root Certification Aut
m 1 Crbmvrmvice Teock

Open the Signed certificate which you have received from Certificate Authority.
Once the certificate is opened, go to Details tab and click on Copy to File button.

Click Next - select Yes, export the private key option.

Lo wou want to export the private key with the certificate?
¥ Yes, export the private key

£ Mo, do nok export the private key

Click Next.

" A 8t 1 T R R 0 A 0 0l kR S 8 08t )

¥ Personal Information Exchange - PRCS #12 { PR

[™ Include all certificates in the certification path if possible
[ Delete the private key if the export is successtul

[ Export all extended properties
R P [ R

Enter your password (double time) to assign to the Keystore - click Next.

Save the .pfx file in the system in the same location where certificate request is created for
easy identification.

Click Next - click Finish.
In the same mmc window, open File menu - select Add/Remove Snap-In option
Select Certificates - click Add.
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Add or Remove Snap-ins

E

o can selact snap-ins For bhis console from those avalable on vour computer and configure the selected set of snap-ins. For
exctensible snap-ins, you can configure which extensions are enabled,

Ao alsble snap-ins: Selectad map-ing:
Snap-in | Yendar - [ Console ook Edi Extensions...

g,g;ﬁ.r_twr Directory Do...  Microsoft Cor,..
A Bctive Directory Sch,..  Microsoft Cor,..

[Bi Active Directory Sibe,.. Microsoft Cor... n
| Active Directary Use... Microsoft Cor,.. Step 2

rosoft Cnr:: Add =

pe Enority  Microsoft Cor,,.
®. Comporert Services  Microsoft Cor,..
TAS Computer Managem... Microsoft Cor...
| |petais Templates Ed... Microsoft Cor...
B pevice Manaoer Microsaft Cor... Ll

Advanced...

Description:

The Certificabes snap-in allkws you bo browss the contents of the certificate stores For yourself, & serice, o & compuber.

O | Cancel

24. Select Service Account.

Certificates snap-in

Thiz znap-in will alwavs manage certificates for:

£ By user account

' Service account

f Computer account

25. Select Local Computer, click Next.

Select Computer x

Select the computer you want thiz znap-in o manage.

—Thi -iF ] % manage;
% |ocal computer: |[the computer this console is running on)
" Another computer: I Browze, . |

[ Allow the selected computer to be changed when launching from the command line. This
only applies if pou zave the conzole.

26. Select the Service Name / AD LDS Instance Name.
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S ——
Certificates snap-in

Select a zervice account ba manage on the local computer.
1

Service account:

Active Directam Certificate Services a

Active Directary Domain Services

Actve Directon \Web Services
]

Application Host Helper Service

Application [dentity

Application [nformation

Application Layer Gateway Service

Application Management

ASP.MET State Service

B ackground Intelligent Transfer Service

B aze Filtering Engine

Certificate Propagation ﬂ

< Back I Finizh I Cancel |

27. Click Finish - click OK. The following Add or Remove Snap-ins window appears.

Add or Remoye Snap-ins

You can select snap-ins For this console From those awvailable on wour computer and configure the selected set
extensible snap-ins, wou can configure which extensions are enabled.

Bvailable snap-ins: Selected snap-ins:
Snap-in | Yendaor | - | Console Root
ﬁ.ﬁ.ctive Directory Do...  Microsoft Cor.,.. BT Certificates - Service (AOLDSPr
:-,71 Ackive Direckory Sch..,  Microsaft Cor,,, |
Ep-r: Ackive Direckory Site, .. Microsaft Cor,,,

: Ackive Directary Use...  Microsoft Cor...
- Activer Contral Microsaft Cor... ]
2 ADEI Edit Microsoft Cor,..

F'.ul:hl:urizath:un Manager Microsoft Cor.., Add > | |

28. In mmc Certificates window - expand Certificates — Service (AD LDS Instance Name) on
Local Computer > Add the AD LDS Signed Certificate in AD LDS Instance Name/Personal
section.

29. Click Next > Browse > select the key store that you have created in previous step (file
extension is .pfx) in File browser.

30. Click Next - Enter the password of key store (entered while creating .pfx file).
31. Click Next > Next = Finish.
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= Consolel - [Console Root' Certificates - Seryice {ADLDSProxkySyncl) on Local Computer',ADAM_ADLD

File  Action Wiew Favorites  Window  Help

®$| AEIEIEEN G

| Console Root Object Type
E| H Certificates - Service (F\DLDSProxySyncl) on Local Computer “| Certificates
8/ DAM_ADLDS
| ADAM_ADLDSProwy yncl'l,Trustu Find Certificates. .. |
- | ADAM_ADLDSPraxySyncliEnter all Tasks Find Certificates. ..
| ADAM_ADLDSProxySyncliInkers
| ADAM_ADLDSProwySynciiTrust Wiew 3
'_' ADAM_ADLDSProxySyncliUnkru Mew Window from Here .
“| ADAM_ADLDSPraxySynct | Third- . Advanced Operations b
| ADAM_ADLDSProwySyncliTrust  Mew Taskpad View. ..
Refresh
Export List. ..
Help

Once it is added, certificate is available as shown below.

P Conselel - [Console oot Certificates - Servioe (ADLDSPronySync ] ) on Locsl Compater’ ADA™_ADLDSProwxy Sy 1 Personal Certificstes]

@ Fie  Adion  Vew Fovrbes Windew  Help

a0l s Him
umnb- [ lsgund-Ta. T Leousd By | [FE——— 1
= Sarvioe [ Ligny C gl addeparver prenadomsn. com adldsizsuer LT Server futhenticstion  <MNore
- ADAM A0 CrsPr ponySynd 1 iPer sonal
Cortifabed
ADEM SO EPPr tooySyree 1 Pt ed Bigat Cortiicption dwthorts

32. In the same way, add the AD LDS certificate’s Root certificate (for example,
pmsnmdomain.com) in AD LDS Instance Name/Trusted Root Certificate Authorities.

33. Add the AD LDS certificate’s Root certificate in AD LDS Instance Name/Trusted
Publishers.

34. Add the other end certificate (for example, Provisioning Manager application certificate) in AD
LDS Instance Name/Trusted People. An example is shown below.

= Consolel - [Console Root]

E File  a&ction Wiew Fawaorites  Window  Help

&= == H
= Mame
=l Certlflcates Service (ADLDSProxySyncl) on Local Compuker ;iCertiFicate:

A0AM_ADLDSProxySyncl\Personal

| ADAM_ADLDSProxySyncl | Trusted Rook Certification Authoritie
| ADEM_ADLDSProxySyncl\Enterprise Trusk
ADAM_ADLDSProxySyncliIntermediate Certification Authoritie
A0AM_ADLDSProxySyncl | Trusked Publishers
ADAM_ADLDSProxySyncl\Untrusted Certificates
ADAM_ADLDSProxySyncl | Third-Party Rook Certification Authc

ADAM_ADLDSProxySyncl i Trusked People

HEHMBBKBKBKE

35. Add the ownership to the added certificates to Network Service.
36. Go to C:\ProgramData\Microsoft\Crypto\RSA\MachineKeys.

37. Right click on each certificate where Lock like icon appears on the files.
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MachineKeys

|\ )vl . = Computer - Local Disk{C:) - ProgramData - Microsoft « Crypto = RSA + Machinekeys

Organize ~  Includeinlibrary «  Sharewith «  New Folder
' Faworites Mame Date modified - Type Size
B Deskiop 15 5d28c67b4abaf af Sh571 secc405F03d_7393c5h4-1644-4afd-921F-207b3dF 31 2he 11/9/2016 512 AW System fils 3KB
4 Downloads 16| Fraab5a9e2f0r2458ab11343dee9e041_73930504-1844-4aFd-901F-207b3dF31 2he 10f21/2016 643 PM System file ZKB
=il Racant Places 155 55530477821 4d0e2beb0debe 3chafeez_7393c5h4-1844-4afd-991F-207b3dF312bc 10{13{2016 8:57 PM System fils ZKE
1) 16602041 9dLc4al FSS3c9852650796_7393cSb4-1844-4aFd-991F-207b3dF 312be /162016 1:06 A System filz 3KE

= Libraries

38. Open Properties - go to Security tab = click Edit - click Add > Enter Network Service.

X

"General Securly | Detais | Previous Versions
Object name:  C:\ProgramD ata'MicrozoftsCrypta\RS4AWM achinek.

Group o user names:

Security |
Object name:  C:\ProgramD ataiMicrozofthCroptotRSA

Group or user names

B2 5YSTEM
82, Admiristrators [wIPROPMSNMybdministrators)

B2 SYSTEM
82, Admiristrators [wIPROPMSNMubdministrators)

Permissions for 5d28c67b4ab4ffaf5b571eecc405f03d ... B4 f
Select Users, Computers, Service Accounts, or Groups

Select this object type:

|uSers, Groups, or Built-in security principals Object Types...

Fiam this Iooatiopummmm——r=— ="

IW‘D'UDWS LCOMEnter "Networ Services" here

Enter the obje ER 3]
NET'wWORE SERVICE] Check Mames

[2]x]

Ta change permissions, click Edit Edi.
Add.. F
Prermissions for 5Y5TEM Allow Deny X e MI ﬂlé
Fp— v Permissions for SYSTEM Allow brem T
Modiy 7 Full contral o = Tk
FRead & execute v Modiy o 4 KB
Fead v Fiead & exeoute m]
Wit v Fiead o e
Special permissions Wiite o . KB
Leain about access control and permissions i@
For special permissions or advanced settings, Advanced 4 KB
click Advanced oK | Cancel | Ay | .
Lean about access contial and permissions G263 i TT7572075 TI0S A atem il IKE

39. Enter the Network Service and select Users, Computer, and

window.

Service Accounts or Groups

40. Give Read, Read & Execute permission - click OK - OK.

l Permissions for 5d28c67h4ab4ffafsbh571eecc405f03d_.

SecLrity |
Object narme:

Grn:-up ar Lzer hames:

C:4ProgramD atahbicrozaft\Cryptoh B SAhd achinek L

|f

Pl BTN Y. X

Permizzions for METWIOREK
SERYICE

Full contral
b odify

Fead & execute
Head

W rite

Add... | Remove | i
Al Deny L
O O = |t
O O |
O
[+ O _d1f
O O .|

b

41. In the same way, provide permissions to all certificates for Network Service user. When you
give the permissions, all the Lock icons get disappeared.
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2.13

. MachineKeys

)v . = Computer ~ Local Disk {C:) ~ ProgramData - Microsoft = Crypto ~ RSA = MachineKeys

organize *  Includeinlibrary = Sharewith = MNew folder

% Faverites Name: Date modified Type Size
B Deskiop %8| EdzBeB7h4abaFFafSbST 1 eeccdnsfoad_7393c5hd-1844-4afd-991F-207hadF 31 2be 11/9/2016 512 AM  System file 3KB
.“ Downloads %] fraabSaae2f0c2455ab11393deede041_7393c5b4- 1544-4afd-991F-207b3dF 31 2he 10§21{2016 6:43PM  System file 2KE
21 Recent Places % 5554047702 1 4dne2heb0debe Scbefee_739305he-1 8- 4afd-001F-207kadF 3 L20e 10/13(2016 857 PM System file 2kB

|22] 18602d419d 1 c4at PSS IcaR5e650796_739305b4-1844-4afd-991F-207b3dF3L2be B/16/2016 1:06 AM  System file IKB

S Vikwavias

42. Restart AD LDS Instance. Test LDAPS for AD LDS by using the below command from PM
installed server.

openssl s_client -connect IPAddress of AD LDS:LDAPS port
For example:
openssl s_client -connect 192.168.26.129:53994

USING AD LDS AS A USER REPOSITORY IN PROVISIONING
MANAGER (PM) APPLICATION

To Import Users into PM, do the following:
1. Login to PM application.

2. Select System menu - select Data Management sub menu - select Active Directory.

[ C D 192.168.26.191/mp/eemmMenu.do

> Mitel | Provisioning Manager

Users Services Administrators System Logs Own Settings

Location Subsystem Data Management Options Email Server Configuration Wizz

Compare with Subsystem | active Directory Server - Change

Backup & Restore
> | | Apply

Scheduling

Active Directory Server |[eOITIEELEE

General Settings

3. Enter the following fields details.
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WS Configure Domains

General Settings

(7 1P Address: « <4 [192 168.26.129
@ Port: <4 (53986

(@ User Name: + ¢4 [adidsadmin
(® Password: ™ N I

@ Confirm Password: 4 [eemennnen

Notification
(¥ Emoail Address:

Rules
() Create Default Password: o
(%) Automatically Remove Users: +
(?) Scan for Removed Users Interval [m]: 30

Extension Handling

Extension/Mailbox Handling: Try assign ctherwise create new extension/mailbox ¥
Extension Mumber Length: 5

Mailbox Handling

Mo OneBox Server subsystem is available.Please initiate through Add Subsystem task.

| Add OneBox Server |

(?) UDF Mapping: Edit. ..

]
o

Remove Active Directory Server Configuration

| Remove Configuration |

For example,
e |P Address: [IP address of AD LDS Instance located server]
e Port: [Normal LDAP port of AD LDS]
e User Name: [administrative user created in AD LDS in “Step V"]
e Password: [Password of above administrative user]
e Confirm Password: [Type the same password as entered in “Password” field]

4. Click on Apply. Authentication is Successful is displayed.
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' Change operation successful

Server

Property Value

General Settings

IP Address 192.168.26.129
Port 33986

User Name adldsadmin
Rules

Create Default Password Yes
Automatically Remove Users Yes

Scan for Removed Users Interval [m] 30
Extension Handling

Extension Mumber Length 5
Mailbox Handling
Create Mailbox Yes

Configure Domains
Mo property set

Done

5. Click Done.
6. Go to Configure Domains tab > click Add.

Domain Configuration - Add

Apply Cancel

() Search Domains: *
(@ Description:
A
(?) Select Location : Mitel *
(7) Select parent department for AD deparments : Mitel *

Extension Templates

[ Apply | | Cancel |
Add the following details.
e Search Domains: [The Domain which is created at AD LDS Side After
Step X]
For example, OU=WBMUSers,DC=wbmusersadldsdomain,DC=com
Click Apply - click Done.

Configure the AD LDS Instance details as mentioned below.
Click Apply - click Done.
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Configure Domains

Create

Add

Search Domains Description

Q, / ® @ & OU=WBMUSers,DC=wbmusersadldsdomain,DC=com

Apply

10. Go to Configure Domains tab = click on Synchronization icon [5th icon from left side].

11. Go to Users menu - select User. Once, the synchronization completed.

Users Services Administrators System Logs Own Settings

Usel Departments UDF Mapping Unlock

User

Add

(?) Enter User Name(s), Extension Number, Department: |*

(2 Imported from: Active Directory (AD) ¥
View Maximum rows per page | 200 ¥
T UserId *; LastName <%; First Name %; Extension /Telephony System *; Department(s) <%; Import from %  Customer

12. Enter “*” in Enter User Name(s), Extension Number, and Department field.
13. Select Active Directory (AD) in Imported from drop-down list.
14. Select View to view the list of users who are synchronized from AD LDS.

2.13.1.1 Enabling SSL for PM Application

For the AD Authentication, Description refer to the file number 18/1551-ANF 901 15,
Section 4 of the CPI Document.

Place the certificates of PM at AD LDS side as mentioned in step XII.

2.13.1.2 Enabling AD Authentication in Provisioning Manager (PM) located server

For the AD Authentication, Description refer to the file number 18/1551-ANF 901 15,
Section 4.4 of the CPI Document.

To do this, do as follows:
e Leave the Principal DN Suffix field empty.
e Enter LDAPS port of AD LDS in the port field.
e Except this everything is same as we do for Active Directory.

e After this configuration, restart of PM application and try to login with the
synchronized users from AD LDS.
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2.14 UNINSTALLING AD LDS INSTANCE AND AD LDS ROLES FROM
SERVER

To uninstall AD LDS Instance from the system, do the following:

1. Goto Control Panel - select Programs and Features.

All Control Panel Items
' .

)(_J @ - Control Panel = All Corkrol Panel Ttems -

Adjust your computer’s settings

P Action Center Administrative Tools Eﬂ AutoPlay L3 Color Management
+'Date and Time '@ Default Programs o Device Manager 5 Devices and Printers

'@' Ease of Access Center Falder Options A Forts Internet Options

| £ Jarva (32-bit) £ Keyboard ¥ Mouse bt

& personalization |15 Phone and Madem “é Fower Options [ﬁ Programs and Features

% Remotefpp and Desktop Connections % Sound @Sync Center 1B Systerm

| Texk ko Speech [ Troubleshoaoting .334 User Accounts Fﬂ Windows CardSpace

ﬂWmdows Firewall 1 windows Update

2. Selectthe AD LDS Instance Name - select Uninstall.

{8 Programs and Features

E’ + Cantrol Panel = All Control Panel Ikems = Programs and Features

Control Panel Home Uninstall or change a program

View installed updates To uninstall a program, select it from the list and then dick Uninstall, Change, or Repair,

'?:,‘ Turn Windaws Features on or off

Organize = Uninstal

Instal & program fram the network.

~| PuElisher ~ | Trstal.

| awa(TH) & Update 45 Oracle 112016 9B.0ME 6.0.450
| £|3ava(TM) SE Development Kit 6 Update 45 Oracle 112016 124MB  1.6.0.450

Remove AD LDS Roles from server.

Open Server Manager - select Remove Roles - click Next button in the opened new
dialog window.

B, Server Manasger

Fis  Adior Vew Hep
bl st foll 7 |

Server Mg (WINATSEVMIHELC) Rales.

B Raes

iﬁ i e il ke e

= Roles Summary [ rotes summary e

= Roles: 6 of 17 etaled i Fokes
T Rt ke
Atroe Cwectory Cortficate Seraces

1) hctive Drectory Doman Serices

5. Unselect Active Directory Lightweight Directory Services check box.

|
HRemove Roles Wizard X

Remove Server Roles

Before ‘fou Begin To remave one of more installed roles From this server, dear their check boxes,

Roles: Description:

Canfirmation 7 - - Active Directory Certificate Services
— . . AD C5)is used to create certification
Progress Active Directory Dor:1a|n services authorities and related role services
Brealis R e e T that allow you to issue and manage
Active Diractory Lightweight Directory Services certificates used in a variety of

Active Directory Rights Management Services (Not Indralled) applications.
Application Server (Mat Installed)
DHCP Server (Mot Installed)
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6. Click Next = click Remove in the next dialog windows.

7. Click Close when it is removed successfully.

2.15 ESTABLISHING LDAP CONNECTIONS (IN PM)

Following sequence of steps takes place for LDAP connections after you configure an AD server in
PM:

1. Two connections are established towards AD/ADLDS; one connection is for Notifications task
and the other is for Manual Sync.

2. If AD/ADLDS is down, the above connections will be closed, and a new thread checks the
status of AD/ADLDS server for every 15 seconds.

3. If AD/ADLDS is UP, the current thread will be stopped, and both the connections will get
established.
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3 REFERENCES

For more information, see www.mitel.com, Customer Product Information & Mitel On-Line and Mitel
InfoChannel.
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